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License - (By using this software you agree to the terms and conditions below)

"HAWKEYE" is copyright © 2009 by Hawk SCADA. All rights are reserved
and are trademarks of Olen Booth.

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitutes a legal agreement ("License Agreement") between
you ("Licensee", either as an individual or a single entity) and Hawk SCADA. ("Licensor"), sole worldwide
publisher of the software product "HAWKEYE" ("Software") of which Hawk SCADA is the copyright holder.
BY INSTALLING, COPYING, OR OTHERWISE USING THE SAID SOFTWARE, YOU AGREE TO BE
BOUND BY ALL OF THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement, Olen Booth grants you the
right to use the Software in the manner provided below. If you do not accept the terms and conditions of the
License Agreement, you are to promptly delete each and any copy of the Software from your computer(s).
The Vendor reserves the right to license the same Software to other individuals or entities under a different
license agreement. After accepting this license agreement, the Licensee is permitted to use the Software
under the terms of this agreement for no more than thirty (30) days, and for evaluation purposes only,
without payment to the Vendor. If the Licensee wishes to use the software for more than thirty (30) days
and/or for purposes other than evaluating the Software, the Licensee must purchase a single user license or
a multi-user license from the Vendor. This license bears the name of the licensed person or entity and is not
transferable to any other party. Pricing and availability is subject to change without prior notice. The
Licensee can consult the most recent pricing information by contacting Hawk SCADA offices 8-5 CST
Monday — Friday (662)-324-2721 or office@hawkremote.com. The Licensee has the right to place an
additional copy of the Software on a removable medium for backup purposes to protect the investment
made. Technical support is available for the thirty (30) days directly from the Vendor , in the English
language, at no additional charge. The Software is provided "as is". In no event shall the Vendor or any of
his affiliates be liable for any consequential, special, incidental or indirect damages of any kind arising out of
the delivery, performance or use of this Software, to the maximum extent permitted by applicable law. While
the Software has been developed with great care, it is not possible to warrant that the Software is error free.
The Software is not designed, or intended to be used in any activity that may cause personal injury, death or
any other severe damage or loss. If errors are found in the Software, the Vendor will release a new version
of the Software that no longer contains those errors within a reasonable amount of time after the Vendor is
given an accurate description of those errors. The amount of time considered reasonable will depend on the
complexity and severity of the errors. The Vendor will mention the release at www.hawkremote.com and, at
the Vendor's option, directly contact the Licensee to announce the new release. The Licensee can then, at
their option, upgrade to the latest version or continue to use the older version the Licensee already has. In
either case, no payment to the Vendor is required. In the latter case, the Licensee will no longer be entitled
to technical support until the Licensee has upgraded to the latest version. The Vendor reserves the right to
charge an upgrade fee in the case of major new enhancements or additions to the Software. This major new
version will then start a new version line, which will use version numbers clearly distinguishable from the old
version line. The Licensee has no obligation to upgrade to the new version line and the Vendor will continue
to make available the latest version of the previous version line and release new versions in the old version
line in the case errors are still found, and provide technical support for it. You must not attempt to reverse
compile, modify, translate or disassemble the Software in whole or in part. You must not run the Software
under a debugger or similar tool allowing you to inspect the inner workings of the Software. The Software
remains the exclusive property of the Vendor and can only be sold at the discretion of the Vendor (Hawk
SCADA). You must not give copies of the Software or your license key to other persons or entities. You
must not transfer the Software or your license key to another person or entity. You must also take
reasonable steps to prevent any third party from copying the software from one of your machines without
your permission. Any Licensee which fully complies with the terms in this license agreement may use it
according to the terms of this license agreement

The Vendor reserves the right to revoke your license if you violate any or all of the terms of this license
agreement, without prior notice.
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Chapter 1
HAWKEYE / Hawk Server Overview

/ Web Interface

Internet Firewall

%

Hawkeye

Hawkeye was developed to provide viewing and control of today’s modern SCADA
system. Hawkeye allows authorized users to monitor and control their system safely by
accessing their systems server, a.k.a. “Hawk Server”, through a secure connection.
Access to certain features and parts of the SCADA system are fully customizable by the
system administrator, so operators only have access to areas approved by the system
administrator. Not only does Hawkeye allow complete viewing and secure control of
your SCADA system, but it is also capable of providing detailed reports of system
activity, including Quick Charts and various types of activity reports, all of which can be
printed or saved to your system as a picture file for later viewing. Hawkeye allows the
user to monitor and control their system in real time, while Hawk Server is constantly
collecting and compiling data 24/7, so the user can go back to any period in time and
access data logs and charts in order to review previous system activity. In the following
chapters we’ll cover installation of the Hawkeye software and how to navigate through
the program, as well as many other features of the software.



Chapter 2
HAWKEYE Software Installation & Setup

Download & Installation

e Ifthisis your first time downloading the software on the machine you are
using you can download the latest version of Hawkeye by visiting
www.hawkremote.com/install.

o Upon navagating to this URL you will be prompted to enter a
username and password to access the site. This code is provided to
you by Hawk SCADA with the purchase of your SCADA system.

o Once you have accessed the install website you will see a bullet list of
several different software packages for different Hawk Remote
products. Choose hawkeye/ from this list.

o This will take you to an index of install/hawkeye. From here you can
download any or all of the needed Hawkeye files. Hawkeye.exe will
be the most current version of the software. There will usually be a
previous version as well, in the event that a user needs a previous
install.

¢ Ifyou already have Hawkeye on your computer and need to upgrade to
the latest install update you are just a few mouse clicks away with Hawk
Updater.

O Open Hawkeye and go to the “Help” menu located toward the top left
of your screen. From there choose “Launch Updater”.

O At this point Hawkeye will shut down and the Hawk Update screen
will appear. From this screen click the button toward the left that says
“Connect”. The updater will connect with the hawk remote database
and display the appropriate files available for installation.

O Next click the button just to the right called “Get Updates”.

®  Once you click get updates you will be prompted to approve
the current file of Hawkeye to be overwritten. Say yes to the
following prompts. Once updates are fully installed the
program will notify you, and prompt you to restart Hawkeye.
Click yes if you would like to restart Hawkeye at this time.

®= Now you have the latest version of Hawkeye installed on your
computer.



Setting up a secure connection

* To setup a secure connection, go to the edit menu at the top of the
main screen and select Account Information. That action will pull up
the Hawk Connect Menu (Pictured Below)
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From the Hawk Connect menu you can access multiple systems or profiles from the same
computer. If your system is already setup and running your profile may already be
established. If so, select it from the dropdown menu and press the Connect button. If you
are connecting to your desired Hawk SCADA system for the first time you will make
your initial connection from this screen. To start, go ahead and fill in the information
required, which will be provided to you by your system administrator, in order to make
the secure connection with Hawk Server via Hawkeye. You can also save additional
system profiles that you would like to add by using the add button and the save button
when you are finished. The Save and Exit button would be used if you have added the
last profile you are going to add and want to save and exit the screen while staying
connected to the profile you are currently using. Finally, if you want to add a profile and
immediately save and connect, using the profile on screen, go ahead and press the
Connect button after you have entered your information. The profile you entered will be
saved to your list and you will be immediately connected securely to the Hawk Server at
your selected system via Hawkeye.

For further questions regarding networking please contact your system network

administrator. For specific questions regarding the Hawkeye software you may also call
Hawk SCADA 8AM-5PM M-F CST at 662-324-2721 or 877-700-HAWK.



Chapter 3
HAWKEYE Database Navigation

(Toolbar Button Function)
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Starting at the top left of the toolbar on your screen, and moving to the right, we’ll cover
the functions of the buttons available on your Hawkeye toolbar.

* Connect: Connects the user / operator to the SCADA system through a secure
network connection.

* Disconnect: Disconnects the user / operator from the secure connection to the
SCADA system.

* Trend (Strip Chart): Opens the Multi Chart function page of Hawkeye. Here you
have the ability to chart and graph information pertaining to multiple pages / sites
(RTUs) in your system at one time. More details on charting will be covered later
in this manual.

* Home: This button returns you to “Page 1” of your system, which is traditionally a
system “Overview”, from wherever you are in your system layout.

* Left Arrow: This button pertains to the dropdown box to it’s right. Pressing this
button will take you to the page next up the list from the site you are currently
looking at. If you are currently looking at your system “Overview” (usually page 1)
this button will not function, as you are already at the top of your list.

* Page Select Menu: This drop down menu displays the name of the page that
you are currently viewing. To change your viewed page simply click the down
arrow on the right of the box and all of your available pages will be displayed.
From there you can click on any page in the list and be transported to that page.
You can also use the arrow keys located on either side of the drop down menu to
navigate between pages in sequential order of your list.

* Right Arrow: This key will take you to the next page down your list until you
reach the bottom of the list. When you have reached the last page on your list
this key will not function.

o Note: In regards to the previous three items (left arrow, page select, &
right arrow) you can also use the scroll button on your mouse to scroll up
and down the list of pages in your system.

* Drop Down Data Fetch Menu: This drop down menu allows the user to specify
at what interval he or she would like Hawkeye to retrieve current data from the
HawkServer database. In the example pictured Hawkeye is “fetching” new data
every 30 seconds. Depending on connection speeds available Hawkeye can be
set to retrieve data as quickly as every 5 seconds and as long as every 30



minutes. From this menu data retrieval intervals can be easily set to the users
discretion.

* Fetch: Displays time elapsed since last data packet was received and allows
user to request immediate delivery of a new data packet by pressing button.

(Menu Bar)
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Starting at the top left we will discuss each menu available on the top row of the
Hawkeye toolbar.

* File: From the file menu you can exit the system or reset the page view size.

* System Setup: Available to administration only, this menu is covered in the
administrative chapter.

» Edit: From the edit menu you can edit your account information. (tags, users,
groups, and admin login information available from admin login.)

* View: From the view menu you can open viewing windows for event logs,
reports, debugging, and devices.

* Refresh: This menu allows the user to refresh tags, screens, Hawk Server, and
GPS and Device Status.

* Info: Accessing this menu provides the user with general software and system
information

* Help: This menu provides access to remote computer support as well as the
latest Hawkeye updates available.



Chapter 4

HAWKEYE Screen Views

Overview Screen
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Above is a sample picture of the main overview screen of Hawkeye. This screen would
traditionally be Page 1 in your page order. Here, after making your secure connection
to Hawk Server, you see a graphic representation of your complete SCADA system. In
this example “overview” screen the sample city’s water system is displayed, showing
current data for each of their sites, including towers and ground storage tanks. All items
on this page are fully interactive and display current “at a glance” data for each site (in
the example the user has selected that current data be retrieved every 30 seconds from
each site. Data retrieval times are customizable depending on connection speeds and
desires of the user). Color schemes for different types of notifications are customizable as
well. To view more detailed information on each system site you can select a specific site
from the drop down menu at the top center of the screen, or go through your sites in order
using the arrow keys on either side of the drop down menu.



Sub Screen Overview

it View Refresh Info Help

oot | A T 5 Crn) Hone | <SRN 7 - |EEm

OveraViw | it View| Command iskoy

Church Well

o ouAM
< ™20 gnoam

] Encryption: ECDHE-RSA-AES256-GCM-5HA3E4

This next example (pictured above) is one of the sub screens available in the drop down
menu on the Hawkeye tool bar. By accessing the drop down menu you can visit any one
of your pages, or sub screens, for more detailed information and control options. Fully
customizable to your needs, each Hawkeye sub screen can be set up to show whatever
data the user desires, and have needed control options available (taking any system
control action from inside the Hawkeye system requires security clearance. Security
clearance is covered at a later point in the manual). The layout of these screens is fully
customizable, as there are no set parameters of where something has to be. If you don’t
like where a gauge or image is located you can move it. If you want to display another
item, or “Tag” on the screen you can easily do that from the Tag menu (Edit > Tags, this
will be covered in a later chapter called Viewing / Editing Tags and Subtags)
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Above is a second example of a Hawkeye sub screen being utilized in a different
industry. In this example Hawkeye is monitoring ground pressures at a large coal mining
operation. As you can see this sub screen has a much different appearance from the
previous water related screen. Instead of monitoring tank levels and pump operation,
Hawkeye is monitoring ground pressure at a location in a coal mine. The data gathering
principles that Hawkeye employees can be utilized in any industry. The program is taken
and customized by Hawk SCADA specifically for the users operation.
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HAWKEYE Charts Overview

Quick Chart Overview
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As pictured in the example above, a “Quick Chart” can be accessed by right-clicking on
any graphic representation in Hawkeye, and selecting quick-chart from the menu. For
example, if you wanted to see a chart of data for a particular water tank in your system
that you see represented in the overview or on a sub screen, just right click on that image,
select quick chart in the menu, and Hawkeye will produce a Quick Chart for you. Once
the Quick Chart is open you can customize the date range you want the chart to show.
You can also view the data in a grid format, view daily operation reports, or even view a

“Min / Average / Max” chart to show the full range of this sites activity (example
pictured on the next page)
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“Min/Avg/Max” Chart Overview
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As mentioned on the previous page, the Hawkeye “Min/Avg/Max” chart is just what it
sounds like. It complies data for that specific site, within the date range set by the user, at
minimum, average, and maximum, levels, and represents them all on one chart. This is a
valuable tool in evaluating overall system performance.

Note: All Hawkeye “Quick Charts” are savable and printable, so you can save PDF
images of these charts to email to your supervisor, or you can print them to take to a
meeting or presentation, or just for your files. Hawkeye concentrates not only on
allowing you to view the current state of your system, but allows you to go back and view

detailed data from any day your system has been in operation since the software
installation.
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Trend Chart (Multi Chart) Overview
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A “Trend Chart” or multi chart (sample pictured above, data taken from a Waste Water
Lift Station) allows the user to see data charted for multiple pages or locations in their
system all on one convenient chart. This type of chart can be accessed from the toolbar
on the main screen, or any sub screen, of Hawkeye using the button labled (Trend (Strip
Chart)). Items or pages to be charted can be selected from the menus in the top center of
the screen. From here you can select one item to chart, or as many as you like from the
available list. All items check marked will appear on the same chart. Specific date ranges
for the chart can be set using the handy calendars at the top left of the screen. Once your
selection is made use the button “Update Graft” to refresh the chart. For setting some
predetermined time range parameters quickly you can utilized the buttons labeled
“Today, Yesterday, Last 7 days, and Last Month”.
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Right Click / Mode Men
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As shown in the example illustration above, depicting a wastewater lift station, “right
clicking” on an object in Hawkeye brings up a menu that allows the user to perform
several tasks. Of course you can call up a “quick chart” for charting data for that object.
You can also enter edit mode, which will allow you to resize or move an object, change
your page setup, or clone an object.

Let’s take a moment to talk about a few of these “right-click menu” commands:

*  Quick Chart: Allows you to immediately pull up a customizable quick chart for
the item chosen.

* Edit Mode: Edit mode allows the user to edit objects on the current page. When
edit mode is entered, control of all objects on the page is suspended. This allows
the user to edit any object on the page. To exit edit mode click on it again from
the right click menu.

* Size Object:This selection allows the user to adjust the size of the object selected.
This is also the first step used in the process on this menu called “Clone Object”.

15



* Move Object: This selection allows the user to move the object on any other spot
on the page.

* Setup Page: Clicking “Setup Page” will take you to the Overall View Edit screen.
From here you can add different types of objects to the page (Angular Meter,
Digital Meter, LEDs, Status, Tanks, Graft Items, and Buttons) You can position
these new objects using the data grid to the right side of the menu, or later you can
manually move them to anywhere on the screen using the Move Object feature
that was previously discussed. (We’ll discuss this feature more a little later in the
manual in the administrative chapter)

¢ Mark Image Upper Left Corner: (Only valid on map view type pages displaying
GPS related items.) Upon making this selection go to the very top left corner of
the image on your screen and click. Now Hawkeye will ask you to “OK” and note
the latitude and longitude coordinates of the spot you have selected. Now the
program will use these coordinates in conjunction with the coordinates you mark
in the lower right corner (next menu item) to map GPS coordinates for any object
on the screen.

* Mark Image Lower Right Corner: (Only valid on map view type pages
displaying GPS related items.) Upon making this selection go to the very bottom
right corner of the image on your screen and click. Now Hawkeye will ask you to
“OK” and note the latitude and longitude coordinates of the spot you have
selected. Now the program will use these coordinates in conjunction with the
coordinates you mark in the top left corner (previous menu item) to map GPS
coordinates for any object on the screen.

* Clone Object: This feature is handy in organizing your page aesthetically. For
example, if you had several meters you had created on your page and you wanted
them all to be the same size, you could manually size each of them, or you could
much more quickly clone the object’s size.

o To Clone an Object you would start by choosing the object that has the
size that you want the other objects to reference and right clicking on that
object. You will then see the menu item “Clone Object” is grayed out.
That is because you have not yet given Hawkeye a reference to clone. At
this point you need to choose “Size Object”. When the size object menu
appears select the button “Copy H&W”. This copies the height and width
of the object you have selected and gives Hawkeye an object cloning
reference. Now you can close that sizing window and go to those other
meters we talked about, right click on each one and click “Clone Object”.
When you do that each meter should change itself to the size of the
reference object you first selected.

¢ Save Changes: Using this command will save any changes you have made. You
can also accomplish this task by using the save changes button toward the top
right of your screen.

Note: After making any significant changes to the appearance of a page you will want to
go to the “Refresh” menu and select “Refresh Screens” so all of your changes will
represented in the page views.

16
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Chapter 5

HAWKEYE Tags
(Viewing and editing tags and subtags)
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In this chapter we’ll talk about Tags. A “Tag” in Hawkeye is basically anything, or any

variable, that the user wants to monitor. To access your tag menu go to the Edit menu at

the top of the screen and from the Edit menu select Tags. You are now viewing a menu

where you can view and edit device groups, tags, and sub tags.

From this “Tag screen”, to view or edit a tag, all system device group names are listed in

the left side of the box. Once you have selected a device group, by left clicking on it (a

black arrow denotes the group selected), all tags associated with that device group appear
in the menu area located in the right side of the box. As shown in the example
illustration, once you click on a tag in the menu to the right (selection also denoted by a

black arrow), any sub tags associated with that tag you have clicked on will appear in the

bottom box.
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From this screen there are many common tasks that a user may want to take care of. For
example:

Device Group names are on display to the left.
Tags associated with the selected device group are located in the box to the right.
Selecting a tag, by clicking the box just to the left of the name will allow you to
edit the short and long labels (names) of the tag should you wish that tag to
appear under a different name.

o Subtags associated with the currently selected tag appear in the box at the

bottom of the screen.

Units of measurement can be changed from ft, to PSI, or whatever unit has been
established for use with a device.
Last Value displays the last known value recorded for the selected tag.
Meter Scaling can be easily changed in the box toward the center of the page
called Meter. Here, if you had an angular meter associated with a device for
example, you could adjust where the coloring of the meter changes. In the
example picture the meter goes from bright green to red at 106. If you wanted to
adjust it to go to red at 111 then change the upper green box to 110. Easy as that
to change the scaling of a meter.
Short Lists and Long List (Effects what tags appear when a device group is
selected): The list of tags associated with a device group appear in the box to the
right, and sub tags below. When you click on a device group the “short list” of
tags most often used appears in the box to the right. If you know of a tag that is in
existence, but it is not appearing in the list, uncheck the box “show short list”.
This will expose the full list of tags available. From this point you can locate the
tag you wish to be in the short list and select it. Once selected place a check in
the box above labeled “ place tag on short list”. Now when you show the short
list that tag will be there.

Note: The “Control Rights” tab on the edit >tags page will be discussed in chapter 6
under Hawkeye inside security clearance. This will be helpful in setting up command
control for various users.
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Chapter 6
HAWKEYE Administrative / System Control

In this chapter we’ll discuss operating Hawkeye from an administrative standpoint. As
the system administrator, you have the ability to view and control every aspect of your
Hawk SCADA system, as well as setup new pages, edit parameters, create device groups,
tags, and subtags, and a slew of other operations. Also, as the system administrator you
have the ability to set certain levels of security clearance for other operators under you.
You may have certain users working in your system that only need access and /or control
to a certain part of the SCADA system. In this chapter, amongst other things, we’ll talk
about setting up that security framework so only authorized users have access to any or
just certain parts of your system.

To start, let’s discuss the “Setup Page” command located in your right click menu.

Ml Overall view edit Q@@

File Edit SQL Export

| o fof+faf]]

Add Object ‘ Angluar Meter ‘ Digital Meters LEDs ‘ Status ‘ Tanks | Buttons ‘
Tree View I Page ]
| | | | + | | v | X | X Delete | Save and Update | Save Data Grid changes |
Tag |obiecl |Device Tag |DbiectWidth | ObjectHeight| ObjectTop | ObjectlLeft
1 * 7 57
’OV9NI ew Hampton Level -~ J
High Alarm
High Limit
Device [7 Use Long Name Low Alarm
Alex Tower A |Low Limit
Bridgetown P1 average starts per day
Comm_status P1 Failure to start
Craft Tower P1 max starts per hour
Faithaven P1 overtemy
Magnola/Methodist Tank P1 Seal Fail
Metro P1 total number of starts
Mineral Wells P2 average starts per day
Mineral_wells v |P2Failure to start

P2 max starts per hour
. P2 overtemp
Link < P2 Runtime
P2 Seal Fail
P2 total number of starts
P3 average starts per day
P3 Failure to start
P3 max starts per hour
P3 max starts per hour
P3 Runtime
P3 total number of starts
Power Fault
Pump 1
Pump 2 ™

The setup page will open to the “Tree View” tab of the page. From here you can
complete different tasks such as creating a new page or mapping objects on a created
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page to receive data from a specific point. To start understanding this page lets talk a
little bit about the layout and the tools available.

* Add Object: This button allows you to add a new object to the selected page.
First select the type of object you would like to add by selecting it from one of the
adjacent buttons. Next click “Add Object” to add that particular type of object to
the selected page. From there you can map the new object to the correct tag by
selecting the correct object in the grid with the black arrow to it’s left. Next select
the correct device in the menu to the left, and finally select the appropriate tag in
the center menu. Make sure to save using the checkmark box if this is your last
move before exiting the screen. Your changes will not be represented until you go
to the refresh menu on the toolbar and choose to refresh tags and screens.

* Angular Meters: Shows you all angular meters active on the given page you
have selected, and allows you to create a new angular meter on a selected page.

* Digital Meters: Shows you all digital meters active on the given page you have
selected, and allows you to create a new digital meter on a selected page.

* LEDs: Shows you all LEDs active on the given page you have selected, and
allows you to create a new LED on a selected page.

* Status: Shows you all status indicators active on the given page you have
selected, and allows you to create a new status indicator on a selected page.

* Tanks: Shows you all Tank meters active on the given page you have selected,
and allows you to create a new Tank meter on a selected page.

* Buttons: Shows you all buttons active on the given page you have selected, and
allows you to create a new button on a selected page.

Mapping Objects to the correct Tags

The Device menu at the left shows you the current pages available to choose from in your
system, the tag menu in the middle of the page shows you the particular tags available on
that page. Items such as meters, status indicators, LEDs, Buttons, etc, can be mapped to
any tag that you want the Object you have chosen to monitor or control. It is important to
note that any actions you perform from here will be auto saved as you go. To map a tag
to a particular object that has already been created, select the object type from the buttons
across the top of the menu (ex. Angular Meter). All current objects of that type, for the
“Device” you have selected, will be shown in the grid. First go to the grid and select the
object you want to map by placing the black arrow to it’s left with a left click. Next select
the device from the left menu, and finally select the tag that you want the meter to
monitor from the tag menu. That should do it. Now your Object or Device is viewing the
tag you have selected at on the page you selected. Don’t forget to save before you exit the
screen if this is your last action. If you have the option to save the checkmark will be
black. If the checkmark is grayed out there are no changes to be saved since the last save.
Once you have made changes to devices or tags you must go to the refresh menu in the
upper menu bar and refresh tags and screens before those changes will be visible to you.
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EIBIX

M Overall view edit

File Edit SQL Export
Ml afwfm|#|a] ]
Add Object | Angluar Meter ‘ Digital Meters LEDs ‘ Status | Tanks | Buttons |
Tree View
-« | « | > | > | + | = | - | ‘ | Load Background ‘ Delete all Objects on this page Paste All Object(s) Copy Page Object to Clipbaord
aid |UserGroup |F‘os |Name |Image_Local ~
| | 1000 1 1 Overview olive_branch_2014.bmp
1000 1 2 Pleasant West 2w_2p_gst_el.bmp
z 1000 1 3 Pleasant North Et_and_GST.bmp
| | 1000 1 4 Pleasant South PHs.bmp
| | 1000 1 5 Bridgetown Et_and_GST.bmp
| | 1000 1 B Metio WTP Et_and_GST.bmp
|| 1000 1 7 Polk WTP/LC300 Et_and_GST.bmp
| | 1000 1 8 KentwTP Et_and_GST.bmp
| | 1000 1 9 Mag Tank Et_and_GST.bmp
| | 1000 1 10 Pumping Stations Pump_station.bmp
| | 1000 1 11 Hampton Inn Lift Station Lift_Station_v2.bmp
| | 1000 1 12 Yaweah Lift Station Lift_Station_v2.bmp
1000 1 13 Bethel Park Lift Station Lift_Station_v2.bmp
: 1000 1 14 Miller Station Lift Station Lift_Station_v2.bmp
| | 1000 1 19 Comm Status blank.bmp
| | 1000 1 20 Free Chlorine levels blank.bmp
| | 1000 1 21 MWGL Gas Regulator (Run 1) Gas_Reg_station_1.bmp
| | 1000 1 22 Midtown + Collage & Craft Pump_station.bmp
| | 1000 1 23 Faithaven WTP PHs.bmp
| | 1000 1 24 Methodist Water Tower single_tank_sg.bmp
| | 1000 1 25 MWL Gas Regulator (Run 2) Gas_Reg_station_1.bmp
| | 1000 1 26 & and R Gas Regulator (Run 1) Gas_Reg_station_1.bmp
| | 1000 1 27 A and R Gas Regulator (Run 2) Gas_Reg_station_1.bmp
| | 1000 1 28 A and R Gas Regulator (Run 3) Gas_Reg_station_1.bmp
| | 1000 1 29 Hungerford Gas Regulator blank.bmp
| | 1000 1 30 Kent'WTP Control blank.bmp
|| 1000 1 31 Polk Lane (Hawk) Et_and_GST.bmp
v
< >

As a user, if you wanted to create an additional page that looked in appearance like
another page that you already have, but you wanted to create that page for a different
monitoring location, and map the objects on that page to different items in the field, you
would use the page tab. From here you can easily select any page that you currently have
created. After you have selected the desired page to clone use the button that says “copy
page object to clipboard”. The software will let you know how many objects it has copied
to the clipboard. From here create your new page by using the plus sign button located
toward the top left of your screen. Add your new page, naming it appropriately and
numbering it where you want it to fall in your list. Also, make sure you assign it to the
appropriate user group. From this point select your new page and use the button that says
“paste all objects”. Your objects will be pasted to the newly created page. Now, your
graphical layout is complete. Your next step is to map all of the objects on the new page
to monitor the correct tags. To do this reference the previous discussion just before this at
the beginning of Ch. 6
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HAWKEYE Inside Security Clearance

As mentioned previously, Hawkeye takes your systems security seriously. As well as
requiring specific login credentials through a secure connection to access your system,
any control actions performed once inside the system require further administrator
established security credentials to perform. Upon performing a system control action the
operator can be prompted (at the system administrators discretion) to enter a pass code
before Hawkeye will allow this action to take place (pass code panel illustrated below).
Data can be viewed for any site that the user is allowed to see, but in order to take any
control actions you must have security clearance pass codes. However if deemed
unnecessary, pass code requirements can be bypassed for that control option by the
system administrator.

Enter code
1] 2| 3
4 5| 6
7, 8| 9
. 0 CE
Exit | Enter
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Control Rights are available from the Edit>tags menu under the tab called “Control
Rights”

= Dore DX
File Functions
l<|<‘>|>||—|A| | [ % NewTag [Level [ 39
Analog Setupl Analog Grid] Subkags] Devicesl Data Processing  Control Rights |Scans|
| =1 = = 7l )
pos [ Active Conformation
tag |
Control word
r
’ Update I~ Waste Water Watchers
e I ‘waste Water Control
™ Gas Dept Watchers
Check All ™ Gas Dept Contolers
[~ Admin
Clear Al

From this menu the administrator can decide what users have command rights to take a
command control action on a sub tag of a tag (In other words, who can push buttons or
take control actions). Users are placed into the appropriate Relay Control Group by the
system administrator. Next, the Relay Control Group that needs to have the ability to take
command action on a particular tag/subtag should be check marked. From here, if the
administrator wants the users to have to enter a pass code to take that action the box
labeled (recommended in most cases) Active Conformation should be checked. This will
cause the Pass code panel to appear when the user takes that command. This setup
accomplishes two tasks. One, it makes sure only the user who knows his or her pass code
can take command action on any device requiring a code entry. Two, when that user
enters their code that event is logged in an activity chart that can be reviewed. This
Command History is located on any main system page, under the tab labeled
“Command History” toward the top left corner. This tab works in a similar fashion to a
“quick chart”, as you can select a date range to view commands that were made. Should
you want to see who made a certain command it will be there in the “Command History”
tab along with detailed information about the command made.
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Chapter 7

HAWKEYE Reports (Saving and Printing)

All Hawkeye charts and reports are savable and printable, so you can save PDF images of
these charts to email or archive, or you can print them to take to a meeting or
presentation, or just for your files. Hawkeye concentrates not only on allowing you to
view the current state of your system, but allows you to go back and view detailed data
from any day your system has been in operation since the software installation.

To start, open the chart or report that you would like to print or save as a PDF, go to the
file menu and you will see options to print or to create a PDF. Creating PDFs of the
charts you are going to print, and saving them to a file for future reference is a very
handy way to keep records of when you pulled certain information. It’s also an easy way
to email reports to others that are off site. It is suggested to come up with a good file
management system to store your PDF reports in so you can easily locate and access
them in the future, but of course you can always just print reports for the now and file
your hard copies for any records that may be needed later. The choice is yours.
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